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Welcome to the QuickBooks Software Development Kit (SDK) Version 6.0 R2. 
This software is designed for use with US editions of QuickBooks 2007 and 
QuickBooks Merchant Service. In addition, selected features of this software 
can be used with US editions of QuickBooks 2002, 2003, 2004, 2005, 2006, 
QuickBooks Online Edition, and Canadian and UK editions of QuickBooks (2003 
and later). 
The system requirements for the QuickBooks SDK are the same as those for the version of 
QuickBooks that is running. QuickBooks 2007 will run on Microsoft Windows 2000, Windows 
XP, and Windows Vista. QuickBooks 2006 will run on Windows 2000 and Windows XP. 
QuickBooks 2005 and 2004 will run on Microsoft Windows 98, 2000, Me, or XP operating 
systems. QuickBooks 2002 and 2003 will run on Windows NT, 98, 2000, Me, or XP operating 
systems.(The SDK does not run in unattended mode—that is, with automatic login—on 
Windows 98, First Edition; it does run in unattended mode on Windows 98 Second Edition on 
QuickBooks 2005 and earlier.)

Changes Made in the 6.0 R3 Release
The main purpose of the R3 release is to fix an installer bug in the R2 release where updates 
an existing installation did not occur properly. 

Also, we would like to note that if you use our merge modules, there is a dependency on both 
C++ 7.0 and C++ 8.0. The C++ 8.0 merge modules from Microsoft are:

• Microsoft_VC80_CRT_x86.msm

• policy_8_0_Microsoft_VC80_CRT_x86.msm

• Microsoft_VC80_MFC_x86.msm

• policy_8_0_Microsoft_VC80_MFC_x86.msm

Or these can be installed with an installer (vcredist_x86.exe), which is available for download 
from Microsoft.

Changes Made in the 6.0 R2 Release
The main purpose of the R2 release is to fix the QBXMLRP2 merge module and the installers 
that use it so they enable your applications to work correctly with QuickBooks versions earlier 
than QuickBooks 2007 and also work more smoothly on Windows Vista. You may distribute 
these merge modules and installers but please do not distribute those from the original 
QuickBooks SDK 6.0 [R1] release.

• New QBXMLRP2 merge modules/installers:
QBXMLRP2.msm, QBXMLRP2Installer.exe, QBFC5_0Installer.exe, QBFC6_0Installer.exe
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A new version of the QBOE Connector is also being released to address a few small bugs. You 
are encouraged to use and redistribute this R2 version of the QBOE connector rather than the 
one shipped with QuickBooks SDK 6.0 R1.

• New QBOEConnector merge modules/installers:
QBOEConnector.msm, QBOEConnectorInstaller.exe

The R2 release also provides new material related to the QuickBooks Web connector (QBWC):

• Two new web service samples for QBWC: 
A C# sample that subscribes to QB events and handles them 
A Java web service sample that shows how to implement the interfaces in Java

• Provides an updated version of the QBWC Programmer’s Guide, which documents the 
enhanced Authenticate interface supported by QBWC 1.5, which allows the web service 
to specify the number of seconds before a QBWC update occurs again for that web 
service, and the minimum allowed update interval.

• Note: the QBWC web method interface “sendRequestXML” formerly required the Country 
parameter if the Style was set to Document or RPC. Now, the parameter name that must 
be used is always qbXMLCountry.
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Support for QuickBooks Products

The following table of QuickBooks versions and supported qbXML and QBFC 
versions takes precedence over any other such tables in QB SDK 
documentation.

The following table lists the different versions of QuickBooks and the 
corresponding versions of the qbXML specifications that support them. (Note: 
QuickBooks Mac, QuickBooks Basic, UK Simple Start edition, and the Canadian 
QuickBooks Easy Start Edition do not support the SDK.)

Version of QuickBooks
qbXML Specification 
Version

QuickBooks 2007 and Enterprise 7.0 (Using 
QBXMLRP2)

6.0, 5.0, 4.1 4.0, 3.0, 2.1, 
2.0, 1.1, 1.0

QuickBooks 2006 and Enterprise 6.0 (Using 
QBXMLRP2) 

5.0, 4.1 4.0, 3.0, 2.1, 2.0, 
1.1, 1.0 

QuickBooks 2005 and Enterprise 5.0 (R5 and later)
(using QBXMLRP2) 

4.1, 4.0, 3.0, 2.1, 2.0, 1.1, 
1.0 

QuickBooks 2005 (and Enterprise 5.0)
(using QBXMLRP2) 

4.0, 3.0, 2.1, 2.0, 1.1, 1.0 

QuickBooks 2004 (and Enterprise 4.0)
(using QBXMLRP2) 

3.0, 2.1, 2.0, 1.1, 1.0 

QuickBooks 2003, Enterprise 3.0* (R7 and above)
and all later versions of QuickBooks using QBXMLRP

2.1, 2.0, 1.1, 1.0

QuickBooks 2003
(and Enterprise 2.0)*

2.0, 1.1, 1.0

QuickBooks 2002 (R2 and above)
(and Enterprise)*

1.1, 1.0 

QuickBooks 2002 (R1)* 1.0

QuickBooks Online Edition 6.0, 5.0, 4.1, 4.0, 3.0, 2.1, 
2.0

QuickBooks 2004-2007 Canadian
(using QBXMLRP2)

 CA3.0, CA2.0

QuickBooks 2004-2006 UK Editions
(using QBXMLRP2) 

UK3.0, UK2.0

QuickBooks 2003, Canadian and UK Editions, CA2.0. 
UK2.0)* and all later versions of these through Quick-
Books 2006

CA2.0. UK2.0

*Earlier releases of QuickBooks will work with either version of the Request Processor (QBXMLRP2 or 
QBXMLRP). We recommend you upgrade existing applications to use QBXMLRP2. SDK 3.0 and greater features are 
available only with QBXMLRP2; in addition, this Request Processor solves some problems found in the older Request 
Processor.
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The following table lists the different versions of the QuickBooks Foundation 
Class (QBFC) Library and the versions of the qbXML specification that support 
them.

QBFC Library qbXML Specification 
Version

QBFC6
(including support for QuickBooks Online Edition) 

6.0, 5.0, 4.1, 4.0, 3.0, 
2.1, 2.0, 1.1, 1.0

Does NOT support:

CA3.0, CA2.0, UK3.0, 
UK2.0

QBFC5
(including support for QuickBooks Online Edition 
and Canadian Editions of QuickBooks)

5.0, 4.1, 4.0, 3.0, 2.1, 
2.0, 1.1, 1.0, CA3.0, 
CA2.0, UK3.0, UK2.0

QBFC4
(including support for QuickBooks Online Edition 
and Canadian Editions of QuickBooks)

4.0, 3.0, 2.1, 2.0, 1.1, 
1.0, CA3.0, CA2.0

QBFC3
(including support for QuickBooks Online Edition 
and Canadian Editions of QuickBooks)

3.0, 2.1, 2.0, 1.1, 1.0

QBFC2_1
   (including support for QuickBooks Online Edition)

2.1, 2.0, 1.1, 1.0

QBFC2 2.0, 1.1, 1.0

QBFC2CA CA2.0

QBFC 1.1, 1.0
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Changed Behavior We’d Like to Highlight

Some of the following items may be listed elsewhere in the release notes, but 
are listed again here to highlight them.

• The various country-specific qbXML specs (US, Canadian & UK) are being 
merged into one single superset spec. For that reason, the OSR may 
show, in some cases, certain features applicable to one country-version 
but not others. These features will be marked as county-specific in the 
OSR. For example the Canadian-supported SalesTaxCode may show up in 
the OSR for US QuickBooks, but will be identified as not supported for 
QBD (US version). The new unified OSR, which is included in SDK 6.0 as 
a beta, solves this problem nicely, if you want to take a look at that.

• While the currently available CA QB 2003-2007 supports qbXML CA3.0 & 
CA2.0 and the currently available UK QB 2003-2006 supports qbXML UK 
3.0 & UK2.0, these qbXML specs will NOT be supported by any future CA 
or UK QB release. Instead those future releases will support qbXML 1.0 
through 6.0.

• The single merged qbXML specs for US, CA, and UK impacts QBFC6 
especially, in the country parameter for CreateMsgSet. For more details, 
see “New or Modified Files of Interest”.

• In previous releases of the SDK, if QuickBooks threw an unhandled 
exception while processing an SDK request, the SDK would just catch the 
exception, log the internal error, and let QuickBooks continue to run. This 
led to several and unexpected side effects during subsequent QuickBooks 
activity, for example, ghost processes which prevented the closing of 
QuickBooks, and so forth. Starting with QuickBooks 2007, the request 
processor will allow QuickBooks to close down as it should and gracefully 
handle the exception so the client SDK application continues to run

• Starting with SDK 6.0/Quickbooks 2007, more than one application can 
be logged on in QuickBooks in single user mode.

• A new and improved unified OSR is available: you’ll want to check this out. 
Because it is a beta, in this release it is accessible from a link within the 
older, classic OSR. Please let us know what you think, at the IDN OSR 
forum.

• QuickBooks Enterprise Solutions (QBES) 7.0 includes support for 
enhanced list limits, enabling businesses using QBES 7.0 to add tens of 
thousands* of inventory items, customers and vendors as their business 
grows. (There is no change between QuickBooks 2006 and QuickBooks 
2007 in the list limits for QuickBooks Premier, Pro or SimpleStart.)
*Performance testing was optimized at 100,000 list elements. You may 
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see performance degradation as you add more than 100,000 items, 
customers, or vendors.

• For the Customer requests and responses (the only qbXML 6.0 calls that 
will handle full credit card numbers) there's no change to the SDK code 
but the business logic has changed for QuickBooks 2007 so that if the SDK 
application has been granted access to sensitive data but the logged in 
QuickBooks user does not have Sensitive Accounting Activities 
permission, a masked credit card number will be returned.

New file locations for QuickBooks 2007

Those of you who have been using QuickBooks and the QuickBooks SDK are 
probably used to certain default locations for .QBW files and QuickBooks log 
files. In order to work with the forthcoming Windows Vista operating system, 
files that QuickBooks writes to have been moved. By default, QuickBooks 
2006 and earlier put new company files in c:\program files\Intuit\QuickBooks 
along with the QuickBooks program files. 

In QuickBooks 2007 we now suggest c:\documents and settings\All 
Users\Shared Documents\Intuit\QuickBooks\Company Files and if you are 
upgrading from a previous version of QuickBooks (thereby replacing the 
previous version of QuickBooks) the install process will offer to move existing 
company files and the files associated with the company to the new 
recommended location. 

This means that if you have stored the path to the user's company file in your 
application, it may no longer be correct! We only move company files out of 
the c:\Program Files hierarchy, so if your stored path does not include the 
program files hierarchy it will not change as a result of installing QuickBooks 
2007. Similarly, the log and ini files, in particular the qbsdklog.txt file that is 
often needed for troubleshooting issues with SDK-based applications, have 
moved. The log files are now be written to c:\documents and 
settings\<current user>\Local Settings\Application 
Data\Intuit\QuickBooks\log while the qbsdk.ini file is in c:\Documents and 
Settings\All Users\Application Data\COMMON FILES\Intuit\QuickBooks.

Do You Integrate With QBMS?

If your application integrates with the QuickBooks Merchant Service, be sure 
to take a look at some of the important changes in this area. Check the IDN 
website for more information about these changes.
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Summary of New or Changed Features

This summary is divided into two parts. The first part provides an overview of 
the new features in QuickBooks SDK version 6.0. The second part provides a 
detailed listing of changes at the message and element level. 
Note: Except as indicated below, none of the new features listed below apply 
to QBOE.

Part One: Features New or Changed in QB SDK 6.0

The following transaction-related features are new in QB SDK 6.0:
• BillPaymentCheckMod 

• CheckMod 

• CreditCardChargeMod 

• CreditCardCreditMod 

• Ability to create Invoices (InvoiceAdd) from Sales Orders

• JournalEntryMod 

• ReceivePaymentMod 

• TimeTrackingMod 

• VehicleMileageAdd and Query

• Ability to set and query "IsToBeEmailed" field on Invoices & Estimates (in 
Query, Add, and Mod operations) 

• Support for "Other", "Other1" and "Other2" fields in all query, add & mod 
transactions 

• Change TimeTracking to use BillableStatus enum in place of IsBilled & 
IsBillable (to enable indicating that time added has already been billed). 
This change applies to QBOE as well.

The following list-related features are new in QB SDK 6.0:

• AccountMod

• VehicleAdd/Mod/Query

• BillingRateAdd/Query

• Ability to query and modify the 5th address line: this feature allows you 
to specify a block of address lines (Addr1 through Addr5) rather than 
using the City, State, etc. fields. Notice that you’ll get both 
representations back in the response unless you use IncludeRetElement 
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to filter out the unwanted ones.

• SpecialAccountAdd, which allows you to create certain special accounts 
“on the fly”: AccountsPayable, AccountsReceivable, CostOfGoodsSold, 
UndepositedFunds, etc. 

• SpecialItemAdd to allow you to create special items as you need them: 
FinanceCharge, ReimbursableExpenseGroup, 
ReimbursableExpenseSubtotal 

The following credit card transaction-related features are new in QB SDK 6.0:

• Accept only "masked" credit card numbers in SalesReceiptAdd, 
ReceivePaymentAdd, & ARRefundCreditCardAdd transactions

• Enable identification of credit card present ("swipe") transactions 

• Provide a ClientTransactionID field for future use by the QBMS 
reconciliation feature 

Part Two: What Changed in SDK 6.0

The following sections contain details on new request and response messages 
as well as on new and changed elements within response aggregates. See the 
updated Onscreen Reference for complete listings of all messages. Also see 
the example file qbxmlops60.xml.

Table 1:  New Requests/Responses in SDK 6.0

Request Category
AccountMod List
BillingRateAdd List
BillingRateQuery List
BillPaymentCheckMod Transaction
CheckMod Transaction
CreditCardChargeMod Transaction
CreditCardCreditMod Transaction
JournalEntryMod Transaction
ReceivePaymentMod Transaction
SpecialAccountAdd List
SpecialItemAdd List
TimeTrackingMod Transaction
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Table 2:  Aggregates/Elements Added/Changed in 
Requests in SDK 6.0

The following items are not listed in the tables because they are almost 
universal and would obscure other important changes if they were listed 
separately:

• In the CreditCardTxnInfo subaggregates, the following max string lengths 
have been changed: :
- CreditCardPostalCode (from 41 to 18)
- CommericalCardCode (from 50 to 24)
- ResultMessage (from 500 to 60)

VehicleAdd List
VehicleMileageAdd Transaction
VehicleMileageQuery Transaction
VehicleMod List
VehicleQuery List

Request Element Added or Changed
AccountAdd Desc field max character limit increased to 

200.
ARRefundCreditCardAdd/
Query

Added Addr5 and Note elements to Address 
aggregate.

Added TransactionMode to the 
CreditCardTxnInputInfo aggregate.

For the CreditCardTxnResultInfo aggregate, 
reduced the max characters from 500 to 60 in 
the ResultMessage and added the 
ClientTransID.

CheckAdd/Query Added Addr5 and Note elements to BillAddress 
and ShipAddress aggregates.

CreditMemoAdd/Mod/
Query

Added Addr5 and Note elements to BillAddress 
and ShipAddress aggregates.

Added IsToBeEmailed element.

Added Other, Other1, and Other2 elements.
CustomerAdd/Mod/Query Added Addr5 and Note elements to BillAddress 

and ShipAddress aggregates.
EmployeeAdd/Mod/Query Added BillingRateRef element.
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EstimateAdd/Mod/Query Added Addr5 and Note elements to BillAddress 
and ShipAddress aggregates.

Added Other1 and Other2 elements.
HostQuery Added a new aggregate, IncludeListMetaData, 

and new element within the aggregate, 
IncludeMaxCapacity. The HostQueryRet 
returns a separate MaxCapacity value for each 
supported List type.

Applications should use this feature (if qbXML 
6.0 is available) to determine the max # of 
elements for each list type.

InvoiceAdd/ModQuery Added Addr5 and Notes elements to 
BillAddress and ShipAddress aggregates.

Added Other1 and Other2 elements

OtherNameAdd/Mod/Query Added Addr5 and Note elements to 
OtherNameAddress aggregate.

PurchaseOrderAdd/Mod/
Query

Added Addr5 and Note elements to BillAddress 
and ShipAddress aggregates.

Added IsToBeEmailed element.

Added Other, Other1, and Other2 elements.

Added TransactionMode to the 
CreditCardTxnInputInfo aggregate.

For the CreditCardTxnResultInfo aggregate, , 
reduced the max characters from 500 to 60 in 
the ResultMessage and added the 
ClientTransID.

ReceivePaymentAdd/Query Added Addr5 and Note elements to BillAddress 
and ShipAddress aggregates.

Added IsToBeEmailed element.

Added Other, Other1, and Other2 elements.

Added TransactionMode to the 
CreditCardTxnInputInfo aggregate.

For the CreditCardTxnResultInfo aggregate, , 
reduced the max characters from 500 to 60 in 
the ResultMessage and added the 
ClientTransID.
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Table 4:  Enumeration Changes in SDK 6.0

Table 5:  Summary of Changes to Reports in SDK 6.0

SalesOrderAdd/Mod/Query Added Addr5 and Note elements to BillAddress 
and ShipAddress aggregates.

Added IsToBeEmailed element.

Added Other1 and Other2 elements.

SalesReceiptAdd/Mod/
Query

Added Addr5 and Note elements to BillAddress 
and ShipAddress aggregates.

Added IsToBeEmailed element.

Added Other, Other1, and Other2 elements.

Added TransactionMode to the 
CreditCardTxnInputInfo aggregate.

For the CreditCardTxnResultInfo aggregate, , 
reduced the max characters from 500 to 60 in 
the ResultMessage and added the 
ClientTransID.

TimeTrackingAdd and 
Query (ret)

The new BillableStatus enum replaces 
1. "IsBillable" in TimeTrackingAdd 
2. "IsBillable" and "IsBilled" in 
TimeTrackingRet

VendorAdd/Mod/Query Added Addr5 and Note elements to 
VendorAddress aggregate. Added 
BillingRateRef aggregate.

Enum Type Enum Value Added
ListDelType BillingRate, Vehicle
TxnDelType VehicleMileage

Change Report or Filter Type
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Deprecated Features or Features No Longer Supported

The TimeTracking IsBillable and IsBilled fields are replaced by the 
BillableStatus enum in qbXML spec 6.0.

Developers should always use and install the latest request processor 
(QBXMLRP2). You should not be using and calling the original request 
processor (QBXMLRP) because this is likely to be dropped from future versions 
of QuickBooks. This is even more important for products designed to work with 
non-U.S. editions of QuickBooks. (Using a new version of QBXMLRP2 will not 
prevent an application from communicating with older versions of 
QuickBooks.)

QBFC Applications and qbXML Spec Version 6.0

The qbXML specs for US, CA, and UK have been merged into one spec in 
qbXML 6.0. There will be no CA 6.0 spec or UK 6.0 spec. Canadian and UK 
editions of QuickBooks 2004 through 2007 continue to use qbXML CA3.0 or 
UK3.0. Canadian and UK editions of QuickBooks 2008 and later are expected 
to support qbXML 6.0, but will not support qbXML CA3.0, CA2.0, UK3.0, or UK 2.0.

This impacts QBFC6 and later especially, in the country and major version 
parameters for CreateMsgSet. For QBFC6 and beyond, if you supply a country 
value of “CA” or “UK”, the only valid major version value is “6” or greater.

How do you get an application to work with CA and UK at the older spec 
levels (CA2/UK 2.0, CA/UK3.0)? You need to specifically use QBFC5Lib or 
older. For a sample that works with both QBFC6 US (qbXML spec 6.0) and CA/
UK3.0, see the sample program 
QBSDK6.0\samples\qbdt\vb\qbfc\US_CDN_UK_CustomerQuery.

While QBFC3 and later use QBXMLRP2, early versions of QBFC (QBFC2_1, 
QBFC2, QBFC2CA, and the original QBFC) all use QBXMLRP. Therefore, we 
strongly encourage developers using QBFC to install and use the latest 
available version of QBFC* and that when you release a new version of 
software you should particularly avoid using these early versions of QBFC 
(QBFC2_1, QBFC2, QBFC2CA, and the original QBFC).

*Caveat: QBFC5 is the last QBFC version that will support Canadian & UK 
versions of QuickBooks 2006 and earlier.
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Known Bugs and Workarounds

• During installation of QB SDK on a system without QuickBooks installed 
you may encounter this error during the execution of dotnetfxSp1.exe:

“The upgrade patch cannot be installed by the Windows Installer service 
because the program to be upgraded may be missing, or the upgrade 
patch may update a different version of the program. Verify that the 
program to be upgraded exists on your computer and that you have the 
correct upgrade patch.” 

To solve this, install .NET from the Microsoft web site and retry the 
installation.

• The various country-specific qbXML specs (US, Canadian & UK) are being 
merged into one single superset spec. For that reason, the OSR may 
show, in some cases, certain features applicable to one country-version 
but not others. These features will be marked as county-specific in the 
OSR. For example the Canadian-supported SalesTaxCode may show up in 
the OSR for US QuickBooks, but will be identified as not supported for 
QBD (US version). The new unified OSR, which is included in SDK 6.0 as 
a beta, solves this problem nicely, if you want to take a look at that.

• If you perform a CustomerQuery that returns the ShipAddress from a 
QuickBooks 2007 or 2006 company, performance can be slower than in 
previous releases. (The ShipAddress data is returned by default.) You can 
workaround this problem by using IncludeRetElement in the 
CustomerQuery to ask only for the data you need, and don’t include the 
ShipAddress in the return data. You can get the ShipAddress from that 
customer later when or if you need it.

• The following is actually not a bug, but is worthy of note here all the same. 
QuickBooks Simple Start does not support multi-user mode. Accordingly, 
if an integrated application invokes BeginSession and specifies multi-user 
mode, the RequestProcessor will return error code 0x80040436, with the 
message "This application requires Multi User file access mode, but 
QuickBooks Simple Start does not support Multi User access." If the 
application specifies "Do Not Care", they will get single-user mode when 
working with SimpleStart. 

• During SDK installation, you may see a message informing you that the 
UI and eBay sample could not be installed. You can safely ignore and 
dismiss this message as it has no effect and the installation will proceed 
successfully.

• The bug mentioned in this workaround was fixed in SDK 4.0. However this 
workaround is included here for those applications that need to work with 
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older QuickBooks versions for which the bug fix is not available. In 
previous versions of the SDK, if you send an InventoryAdjustmentAddRq 
with a ValueAdjustment that contains only a NewValue element, then the 
resulting QuantityDifference will incorrectly get set to "blank", which 
QuickBooks interprets as "1".  The workaround for this is to include the 
NewQuantity element in the request, setting the value to the same as the 
previous quantity on hand for that inventory item.

• If you use DeliveryPolicy in both a DataEventSubscription and a 
UIEventSubscription, you could set one to DeliverAlways and the other to 
DeliverOnlyIfRunning. In that case, QB will cache your application’s COM 
pointer if the first event for this application in a company file session is 
associated with the DeliverAlways policy.

• If a user installs a copy of Convertible QuickBooks 2006 but does not 
select one of the available editions (Premier, Accountant, Contractor 
edition, etc), and an SDK application is subsequently started, QuickBooks 
will prompt the user to select an edition. The application’s call to 
BeginSession will fail while QuickBooks is being configured for the 
selected edition. The workaround is to have the user finish the process of 
selecting the desired edition and then restart the SDK application.

• QuickBooks Canada does not currently return values stored in the 
Company Data Extension fields.  The bug affects QuickBooks Canada 
versions 2004 through 2007 and may affect QuickBooks UK versions 2004 
through 2006.

• The order of some columns in reports may be different in QuickBooks 
2007 than they were for QuickBooks 2006. This is not a bug, just a heads-
up: the SDK documentation has always warned about assuming any 
column order.

• QuickBooks caches the latest Refnumber for each transaction type. If you 
try to save a transaction using the default Refnumber from the UI, the UI 
will warn you if someone else already saved transaction with the same 
refnumber and give you the opportunity to change it to the new latest 
Refnumber. In the SDK, it simply gets used and you wind up with two 
transactions with the same refnumber.

• In QuickBooks Simple Start edition 2006, it is possible for an SDK 
application to create a subitem for a given item. It is not possible to do 
this in the UI, because the UI for creating items does not allow a subitem 
to be specified. You should avoid doing this in your application when 
running against Simple Start.

• An event is received an event time is generated. This event time should 
match the the time that the event was received. However, in the case of 
some events, the event time is not the modification time of the object but 
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the previously stored time that the object was created or modified. The 
objects for which the event time is reported correctly are those objects 
whose modification times do not get updated when they are changed such 
as Customer Balance, Inventory adjustments. It is a known limitation that 
event times will not always be accurate.

• If QuickBooks Verify is running and an SDK application issues a request, 
the request will not complete until the verify finishes.

• QuickBooks 2007 includes a new Unit of Measure (UOM) feature that is 
not available via the SDK. The result of this is that the SDK will behave as 
if the UOM feature is turned off. Therefore, there could be some visible 
discrepencies between data in QuickBooks UI forms and the way it is 
represented in the data from the SDK requests.

• If QuickBooks 2007 and later is running non hosted, SDK applications 
starting QuickBooks in DoNotCare mode will open QuickBooks in single-
user mode. 

Bugs Fixed in This Release

• In previous releases, if QuickBooks threw an unhandled exception while 
processing an SDK request, the SDK would just catch the exception, log 
the internal error, and let QuickBooks continue to run. This led to several 
and unexpected side effects during subsequent QuickBooks activity, for 
example, ghost processes which prevented the closing of QuickBooks, and 
so forth. Starting with QuickBooks 2007, the request processor will allow 
QuickBooks to close down as it should and gracefully handle the exception 
so the client SDK application continues to run.

• This item is not a bug per se, but is put here due to its importance. In 
QuickBooks 2005 and 2006, if one application logged into QuickBooks in 
single user mode, no other application could log in. This had some 
unwanted side effects when it came to applications monitoring 
QuickBooks events. Starting with QuickBooks 2007, more than one 
application can be logged on in single user mode.

• The NameRangeFilter in queries was affected by the sort order used by 
the QuickBooks user, which yielded unexpected results during the 
iteration through query returns. This occasionally resulted in queries that 
didn’t return all the data that should have been returned. This has been 
fixed.

• In the ItemFixedAssetMod request, if the request contained a 
PurchaseDate and does not also contain the FixedAssetSalesInfoMod 
aggregate, you could experience a NULL pointer exception. This has been 
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fixed.

• In QuickBooks 2006, some extraneous error messages were being written 
to the log file qbsdklog.txt. For example, “CListsNotify::OnNotify(const 
CNotifyDataEdListElement*)invalid CNotify msg enum”. This has been 
fixed in QuickBooks 2007.

Installation Instructions

IMPORTANT

During SDK 6.0 installation, if the eBay SDK has 
previously been installed on your system, the SDK 6.0 
installer may report a failure registering ebay.SDK.tlb. 
This error can safely be ignored and the installation 
will proceed normally.

To install the SDK using the installer, execute QBSDK60.exe. The installer 
also adds a menu (Start>Programs>QuickBooks SDK 6.0>) that provides 
convenient access to SDK tools, samples, and documentation (including the 
Onscreen Reference). You can also access the qbXML Validator and qbXML 
Test applications through the "Send To" context menu for files.

Installing on a System that Doesn’t Have QuickBooks

During installation of QB SDK on a system without QuickBooks installed you 
may encounter this error during the execution of dotnetfxSp1.exe:

“The upgrade patch cannot be installed by the Windows Installer service 
because the program to be upgraded may be missing, or the upgrade patch 
may update a different version of the program. Verify that the program to be 
upgraded exists on your computer and that you have the correct upgrade 
patch.” 

To solve this, install .NET from the Microsoft web site and retry the 
installation.

Registering an Application for QuickBooks Online Edition

Before an application can connect with QuickBooks Online Edition using the 
SDK, it must be registered with the Intuit Developer Network. To register 
your application and obtain an application ID, please follow the instructions in 
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Chapter 2 of the QuickBooks SDK Programmer’s Guide and visit http://
appreg.intuit.com to register your application.

Importing the Correct Library

For Visual C++ applications (if you are not using the QBFC Library), you need 
to import the library named qbxmlrp2.dll, which is installed in C:\Program 
Files\Common Files\Intuit\QuickBooks. For Visual Basic applications, select 
Project > References from within your VB project. Find “QBXMLRP2 1.0 Type 
Library” in the list and check the box next to it, then click OK. If you don’t 
find the entry in the list, you can browse to it.

New or Modified Files of Interest

This release includes documentation, tools, and samples. The following files 
and directories may be of particular interest to you:

• This release includes .NET Primary Interop Assemblies (PIAs) for 
QBXMLRP2, QBFC6, QBFC5, QBFC4, QBFC3, and QBFC2.1. These 
assemblies are included in the redistributable installers and merge 
modules for each library. If you have previously built a local interop 
assembly for use with your .NET integrations, please be sure to update 
them to use the primary interop assemblies included with this release 
instead.

• doc\qbxmlops60.xml, doc\qbmsxmlops20.xml, doc\qbmsxmlso20.xml & 
doc\qbxmlso60.xml
The sample files containing all qbXML and qbmsXML requests/responses, 
and their SignonMsgs requests and responses.

• OSR\OnscreenRef
The Onscreen Reference for SDK 6.0. 

• The New Unified OSR\OnscreenRef
The beta version of the new unified Onscreen Reference for SDK 6.0 and 
later.

All samples require the QBXMLRP2 Request Processor, QuickBooks, and the 
QuickBooks sample product-based company file. Samples new in this release 
may require the latest QuickBooks version (currently QuickBooks 2007). The 
QBXMLRP2 Request Processor is installed in a variety of ways: automatically 
by QuickBooks 2007 and by the redistributable QBXMLRP2_Installer.exe 
installer and QBXMLRP2.msm merge module. The SDK also installs the request 
processor.
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Documentation

A new and improved unified OSR is available: you’ll want to check this out. 
Because it is a beta, in this release it is accessible from a link within the older, 
classic OSR.

This release includes one new document: the QuickBooks Web Connector 
Programmer’s Guide, which is a new document describing how to develop 
web services that work with the QuickBooks web connector. The other 
documents are updated versions of previous documents: the Developer’s 
Guide for QBMS documents the QBMS features in the SDK offering, the QB 
SDK Programmer’s Guide is a comprehensive treatment of QB SDK 
programming, and the Technical Overview provides a high level overview of 
the functionality provided in SDK. All documents are available in both PDF 
and HTML. Along with the other major features in the SDK, the manuals and 
the Onscreen Reference can be conveniently accessed through the Start 
menu.

Tools

A new and improved unified OSR is available: you’ll want to check this out. 
Because it is a beta, in this release it is accessible from a link within the older, 
classic OSR.

The qbXML Validator tool contains new functionality that allows you to 
verify qbXML requests that correspond to these combinations:

- qbXML 6.0, 5.0, 4.1, 4.0, 3.0, 2.1, 2.0, 1.1, 1.0 for U.S. editions of 
QuickBooks

- qbXML 6.0, 5.0, 4.1, 4.0, 3.0, 2.1, and 2.0 for QuickBooks Online 
Edition

- qbmsXML 1.0 for QuickBooks Merchant Service

- qbXML CA3.0 and CA2.0 for Canadian editions of QuickBooks

- - qbXML UK3.0 and UK2.0 for UK editions of QuickBooks

The Validator is installed automatically as part of the SDK installation.  
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The file tools\SDKTest\SDKTestPlus3.exe is an enhanced version of SDKTest 
that uses QBXMLRP2 and allows the user to control every aspect of the 
connection to QuickBooks and can be used to send XML request files to 
QuickBooks. It supports sending subscription request XML as well as data 
integration XML. The source code for this tool is in 
samples\qbdt\vb\qbxml\SDKTestPlus3.

The file tools\SubscriptionManager\SubView.exe is a tool for viewing and 
removing application subscriptions from QuickBooks.

Samples

The Samples directory contains a readme.html (which can be accessed from 
Start > Programs > QuickBooks SDK 6.0 > Samples). This file lists each 
sample and provides links to open the project directory, the project itself, and 
the executable form of the application.

The SDK installer verifies that the MSXML4.0SP2 API from Microsoft is 
installed on your system. If MSXML is not present, the SDK installer will 
install it for you. This API is used by the SDK’s Validator tool and several 
samples. 

Some samples require .NET 2.0. This can be downloaded from the Microsoft 
website.

Downloading MSXML 4.0

If you want to run the sample applications on a system that does not have 
MSXML installed (for example, if you want to use Remote Data Sharing from 
a system that does not have the SDK installed), you will need to install 
MSXML. In addition, if your application is dependent on MSXML Core 
Services, you will need to redistribute that software in your installer. The 
MSXML Core Services software is available from Microsoft

Building the C++ Samples

The #import “qbxmlrp2.dll” statement in the C++ samples allows these 
applications to use the COM interface supported by the QuickBooks SDK. This 
statement will cause an error when you are building the samples in Microsoft 
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Visual Studio if the Include path is not set to include the location of this DLL. 
The DLL is installed with QuickBooks and resides in the QuickBooks common 
directory, currently defined as 
C:\Program Files\Common Files\Intuit\QuickBooks. Add this directory to the 
Include path by choosing the Tools menu, Options command, and the 
Directories tab in Visual Studio.

UIandEventTest Samples

In order to build the EventHandler C++ sample, you will need to specify the 
QuickBooks executable path for the sample project. The method for doing this 
is different for Visual Studio 6.0 and Visual Studio .NET. 

For Visual Studio 6.0, select "Options" from the "Tools" menu. Select the "Di-
rectories" tab and then select "Executable Files". Add the QuickBooks execut-
able path to the list of directories here.

For Visual Studio .NET, select "Properties" from the "Project" menu. Under the 
"C/C++" options, select "General" and add the QuickBooks executable path to 
the "Additional Include Directories". Under the "MIDL" options, also select 
"General" and add the QB path to "Additional Include Directories".

All of these C++ samples also use QBXMLRP2.DLL in the QuickBooks 
"common" directory. The project files currently specify this path as 
C:\Program Files\Common Files\Intuit\QuickBooks. If this path is different on 
your machine, you will need to change it in the project files.

Known Problems in VB Sample Applications

The Visual Basic sample applications allow you to view a response from 
QuickBooks. If you try to view a response that is greater than 32K, you will 
receive an “Out of memory” error.  This happens because the VB sample 
applications use a TextBox control, which has a 32K limit, rather than a 
RichTextBox control. In a Windows 98 or Windows Me environment, this can 
corrupt memory, and the application might not terminate properly.

There is a known issue (not related to qbXML) with the AddReceivePayment 
sample application. The MS Visual Studio application must be installed before 
you can run AddReceivePayment, or you will receive the following error 
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message when you run the application: “Class not registered. You need the 
following file to be installed on your machine. MSSTDFMT.DLL.”

Using Payroll Reports

If your application is accessing a company file that is currently signed up for a 
subscription to a payroll service, you can generate payroll reports and query 
PayrollNonWageItems.

To test this feature, you can use one of Intuit’s sample company files (even 
though it will not be signed up for a subscription to a payroll service). Please 
be aware that QuickBooks will record an artificial creation date to any test data 
that you add to a sample company file.

Future Considerations for UK/Canada Applications

• In the future, we will provide a way for applications to make a single set 
of QuickBooks SDK calls that will work with U.S., Canadian and UK 
versions of QuickBooks.  This may have the result that code written to 
work with current or past versions of Canadian or UK editions of 
QuickBooks (for example, dealing with with sales tax and/or multi-
currency support) may need to be rewritten for these future versions

Deprecation Policy

• You may notice that some items in the OSR are marked as deprecated. 
Deprecated items supported for the release in which they are deprecated, 
in the next major release they will be removed from the spec and their 
functionality will not be available.

If You Have Questions . . .

For IDN support, please visit http://developer.intuit.com/support.

For community support, visit http://idnforums.intuit.com.
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